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SUMMARY & CONCLUSIONS
This document provides detailed instructions for the preparation of draft and the final version of papers that are to be included in the Proceedings of the Annual Reliability and Maintainability Symposium (RAMS).  The instructions are intended to assure that the published papers conform to IEEE standard practices.  They are also intended to make the paper preparation effort as easy as possible.  In fact, authors may and even should use these instructions as a template – simply copying their text into this document and deleting the current content. 
Creating a standard format attractive document requires careful attention to quite a few details.  Here are some, but not all, of the key structural requirements for your paper.
· For the body of the paper, use the Times New Roman font with a 10 point font size for all text, equations, figures and tables.
· For the body of the paper, all text should be “justified” and exactly 12 point line spacing should be used.  Setting these choices is described in the body of this paper. 
· The body of the paper is arranged in a two column layout,
· Special layouts are defined in this paper for equations, tables and figures.
· The title, author identities and keywords are formatted using other font sizes and a one column layout as is described in this paper.
· Do not place footnotes or page numbers on the document.
· Do not place headers or footers of any sort on the document.
· There is also special formatting for the bibliography and the author biographical summaries that appear at the end of the paper.
· Total paper length is expected to be about 5 to 6 pages. Papers over six pages in length will not be accepted. 

Papers are to be prepared using the most recent version available of Microsoft WORD.  These instructions are tailored to the use of that word processor.
Before preparing any paper for inclusion in the RAMS Proceedings, please read this entire document.  The person who actually prepares the publication-ready final version of the paper must comply with the format instructions. 
Be aware that failure to comply fully with these formatting instructions can result in the elimination of your paper from the Symposium program.  Please also note that there have been considerable changes to the format requirements for 2026 and these instructions have been revised to reflect the changes as well as be more complete.
If you have a question concerning the format rules, contact the Program Committee Vice Chair responsible for your paper.  If the question is still not resolved, then contact Joel A. Nachlas, RAMS Proceedings Committee Chair, by e-mail at nachlas@vt.edu.
1. INTRODUCTION
The management committee of the Annual Reliability and Maintainability Symposium (RAMS) is proud of the appearance and technical quality of its Proceedings [1].  While it is the Program Committee that selects the papers that are included in the Symposium, it is you, the author who has the greatest responsibility for both the technical quality and the appearance of your paper.
The committee considers that format compliance contributes to the usefulness of the paper contents by Proceedings readers. In addition, format compliance assures compatibility with the majority of IEEE publications and suitability for inclusion in the IEEE Xplore on-line reference files.  These instructions are intended to help you prepare your paper so that it can be included in the Proceedings.  Please follow them carefully.  They are short, clear, and easy to read. Again, please read this entire document.
Please take special note of the fact that these instructions are new.  They are significantly changed from earlier versions to facilitate the 100% paperless process that has been implemented.  Important changes include the use of Microsoft WORD Styles specific to RAMS with built-in line spacing, the elimination of A4 Paper format, and elimination of LaTeX as a submittal medium.  Other changes include definitive guidance on preparing papers using this template.  The requirements of these instructions are mandatory.
Your paper is required to be submitted electronically in Microsoft WORD.  To satisfy RAMS Proceedings requirements, every paper must be prepared using Microsoft WORD software.  The most recent version of WORD available to you is preferred.  The Times New Roman font is to be used throughout the paper.
Content related requirements include the following:
Papers must be grammatically correct and technically sound with no errors in calculations and equations.
Case studies that prove the theory or claim are encouraged when introducing new concepts or processes. 
Information in figures and tables should be explained in the text.
For clarity, a virgule (slash) is appropriate in titles and acronyms but should be avoided in body text. Instead, select the most precise word rather than relying on slashes or 'and/or,' as they do not effectively convey meaning.
Promoting or advertising specific brand names of R&M software tools is not allowed. 
Company names or organizations not related to the author require approval by the stated company or organization.
2. FORMAT & COMPOSITION
These instructions have been prepared according to the requirements contained herein using the specially designed RAMS Styles in Microsoft WORD.  It is easy to see the correct form merely by looking at this document.  The general layout of all pages is identical and is straightforward to establish using the page setup options under the “Layout” tab at the top of the WORD page.
Click on the “Layout” tab to access the margins, orientation and size specification controls.  For the margins, select “custom margins” and enter:
0.50” for the top margin.
1.0” for the bottom margin.
0.67” for each of the left and right margins
The gutter is 0”
The gutter position is left.
Select “portrait” for orientation and “(Letter) 8.5x11” for size. As papers are submitted electronically, the A4 Paper size is no longer accepted. 
The number of columns is set at one for the title block and is set at two for the balance of the paper except where oversize tables or figures require more space.  As described in Section 3, the title block contains the paper title, the identities of the authors and a short list of keywords. Following the “carriage return” at the end of the list of keywords, insert a “continuous break” in the paper.  To do this, (1) click on the “Layout” tab at the top of the page, (2) click on “breaks” and then (3) click on “continuous” on the drop down list. Once the section break has been inserted, click on columns and select two from the set of available choices.  The result of these choices will be a two column paper with each column measuring 3.5” in width.
It is recognized that there are times in which a table or figure that is to be included in a paper must be wider than 3.5”.  In that case, you should precede the figure or table with a “continuous break” and follow the figure or table with another “continuous break. Then specify a single column format between the two breaks and this will provide space for the oversized display item. 
Be sure to fill the two columns that precede the oversized item.  Below the oversized item, two column formatting should be resumed.
Some further general format considerations are the following.  No headers or footers should be used. No page numbers or footnotes should be used.  Text that might be considered appropriate for a footnote can be placed parenthetically within the text.  Do not use bold formatting or all capitals in the text.
There is a 6-page limit to paper length.  This includes tables and figures, appendices if any, as well as the required reference and biographical summary sections. 
3. HEADINGS & TEXT
The RAMS styles contained within this template specify single spacing for all text and 10-pt type with 6 lines/inch (exactly 12-pt spacing).  Spacing before and after each line of text has been set at 0 in all RAMS text styles.  The text alignment is set to “justified,” which corresponds to block formatting in all RAMS text styles.  Except for headings, tables, and figures, all text should be prepared using these RAMS text styles.
These settings can be initialized as follows.  When the WORD page is displayed with the “Home” tab selected, there is a “paragraph” tab just above the ruler. Click on the “x” on that tab to bring up a text box in which the line spacing and indentation may be selected.
a. Paper Title
Title lines – 18-pt font (3 lines/inch – exactly 24-pt spacing).  (RAMS Title Style)
The title is centered on the page on the first line of the page. This corresponds 1” from the top edge of the paper to the top of the Title line.
Capitalize the first letter of each word, use lower case for the remainder of the word.  Not All Caps!
Do Not Use Bold or Italics.
The Title is limited to a maximum of 100 characters including spaces.
b. Balance of Title Block
Author line(s) – 12-pt font (4 lines/inch – Exactly 18-pt spacing) (RAMS Author Style):
Each author’s name is flush left and may be followed by the author’s degree(s) if desired.  That is, the name should be shown as John R. Doe, PhD. rather than Dr. John R. Doe. 
Separate each name from the employer’s identity with a comma.
Follow this with the company or institution name - use the short name by which the employer is generally known.
Do not include geographical references.
Key words – 10-pt type, 6 lines/inch – Exactly 12-pt spacing. (RAMS Key Words Style)
The legend “Key Words:” is set flush left, followed by a colon and the few appropriate key words that describe your paper.  Try to limit the number of key words to four or five listed in alphabetical sequence.
c. Headings Within Paper
Major headings are centered in 10-pt upper case (capital letters) and are italicized. (RAMS Headings Style)
Subheadings are in 10-pt italics, flush left, and upper and lower case. (RAMS Level 2 Headings Style)
It is strongly recommended that only two levels of headings be used.
All headings are on exactly 12-pt spacing.
An additional 6-pt spacing has been added before and after each heading in the template Heading styles.
All Headings and Level 2 Headings are automatically numbered.
Generally, headings are short. If a heading is longer than one line, it should be set to “hanging” by 0.25” in the paragraph drop down text box.
The Summary and Conclusions Heading is not numbered. (RAMS Summary Heading Style)
The References and Biography headings are not numbered. (RAMS Bio & Ref Heading Style)
d. Text
Text is in 10-pt type (6 lines/inch – Exactly 12-pt spacing). (RAMS Normal)
The first line of each paragraph is indented by 0.25”.
Do not leave blank line(s) between paragraphs.
Insert two (2) spaces following the period at the end of each sentence.
If a paragraph continues after a figure, equation, bullet, etc., do not indent that text. (RAMS Normal Continue Style)
Do not use red or bold text – highlight using italics if necessary.
For numbered or bulleted text, use the “hanging” option with 0.25” in the paragraph drop down text box and place the bullets or numbers at the left margin of the text.
If the final page of the paper is a partial page, balance the two columns by defining a section break of the “continuous” type at the end of the paper.  In many cases, this will result in two exactly balanced columns.  In some cases, the columns will be nearly (but not quite) balanced as a result of references or addresses.  This is acceptable.
Also, do not let WORD force you to avoid “widows” at the top or bottom of a page. The RAMS Styles have this feature disabled.
It is emphasized that the columns should be filled.  Authors should organize their papers to use the maximum of the available space on each page.
The “Headings” styles have “Keep with next” selected to prevent a heading from being isolated at the end of a column.  This may result in a small amount of column imbalance.
4. ILLUSTRATIONS
The person preparing your manuscript is responsible for the effective integration of supporting graphics, tables, and other media into your text.  WORD offers the capability of incorporating tables, figures, diagrams, and photos into a document.  To the extent possible, use the capability that WORD provides.  Here are some additional points.
Do not place graphics within a table.  This prevents proper formatting of the figure or table and interferes with assuring font size compliance.  It also imposes the use of unnecessary quantities of space. 
Whenever possible and suitable, place figures and tables within a single column. 
If necessary, define a new section having single column formatting for the figure or table.
Place a caption below each figure and above each table.  The caption is centered and uses a 10 pt italic font size. (RAMS Figure Caption Style) The spacing of the caption is contained within the style.
Do not use text boxes for captions.  Simply use centered text.
Avoid the use of bold text within all tables and figures.
If you use photographs, be sure the resolution is precise.  Generally, black and white photos work best.  For photographs, use the jpeg format and place the associated captions below the photos.
Bitmapped images must be created using 300 dpi.  For drawings and other graphical images, use gif format.
Bitmapped images should be as small as possible: no more than 256 (8 bit) color or/grayscale, 300 dpi. 
Reduce the number of display colors before making screen shots. The majority of computer applications use fewer than 16 colors for their menus, dialogs, etc. 
Select higher resolutions only for images that a reader will magnify.  Image resolution of bitmapped images does not increase when readers zoom in on an image.
Make sure that any text in the graphic has a minimum point size of 8 points. Text below the minimum point size will not be readable in print.
Do not select “Smooth Graphics.” This option often produces extremely large files that will take a long time to display and print.  
The type of graphics you include will affect the quality and file size of your manuscript.  In general, vector graphics, such as those produced by most presentation and drawing packages, are electronically efficient and will not conflict with conversions to PDF.
5. EQUATIONS
Equations should be numbered consecutively throughout the paper.  They should also be centered (approximately) in the column.  Avoid extending equations across columns (like figures) and over multiple lines.  Be concise, you know you can.
Equation numbers should be flush with the right column margin.  There are several ways to ensure this happens.  One method is to develop your equation and put a number on it as:

(1)
Then, apply the RAMS Equation Number style to the number:

 (1)
Finally, use the tab to move the equation to the center of the column while leaving the number at the right margin.

			(1)
This is a reasonably easy method that will work.  If you have another approach, fine – as long as the result is the same.
Remember, to set the equation size in Microsoft Equation.  Use the 10-pt font for “full size” and set the size of the subscripts and superscripts at 58% (8 pt) with sub-subscripts and sub-superscripts at 42% (6 pt).  Set symbols at 150% (14 pt) and subsymbols at 100% (10 pt).  The result should look like equation (1).
Also, do not place equations within a table and do not add extra lines around equations.  Instead, use the “At Least” 12 pt line spacing and 3 pt before and 3 pt after line spacing in the paragraph drop down text box.
6. RAMS STYLES
The RAMS styles that have been defined for your use are listed in Table 1 below.  Observe that it is sometimes reasonable and efficient to place a table or figure near but a little away from its point of reference in order to conserve space.
Table 1 – RAMS Styles in Microsoft Word RAMS Template
	Paragraph Type
	RAMS Style

	Author line
	RAMS Author

	Biography and Reference Section heading
	RAMS Bio & Ref Heading

	Name and address for Biography
	RAMS Bio Name & Address

	Text for Biography
	RAMS Bio Text

	Bulleted text
	RAMS Bullet

	E-mail address for Biography
	RAMS e-mail

	Equation numbers
	RAMS Equation Number

	Captions for Figures and Tables
	RAMS Figure Caption

	Major (Level1) Section headings
	RAMS Headings

	Key words in title block
	RAMS Key Words

	Minor (Level 2) Section headings
	RAMS Level 2 Headings

	Regular text
	RAMS Normal

	Continuation of regular text after an insertion within a paragraph (no first line indent)
	RAMS Normal Continue

	Reference entries in References section
	RAMS Reference

	Summary and Conclusions Heading (first section in paper)
	RAMS Summary Heading

	Paper Title
	RAMS Title


7. REFERENCE FORMAT
Note the fact that several unnecessary (meaningless) reference citations have been made in this document [3] in order to illustrate their use.  Number your references in your paper sequentially in the order in which you cite them.  In your reference section, list the papers as shown in the References Section - author(s), paper title in quotes, Journal or document in italics with full publication information including date.  Use the RAMS Reference Style for your references.  This style will automatically number your references.
8. Use of AI
Keep in mind that RAMS seeks to publish original work supported by research and practical experience.  
Authors may use AI tools to assist with the following, provided that the original ideas, research, and substantive content were produced by the human author(s):
· Grammar checking, spelling correction, tone improvement, and general language editing
· Checking mathematical and notational consistency of equations and the accuracy of numerical calculations, provided that all such outputs are subsequently verified by the author(s) before submission.
This type of assistance is common practice and is generally outside the scope of mandatory disclosure, though disclosure is still recommended as good practice.
The following uses of AI are strictly prohibited under IEEE policy:
· Submitting AI-generated content without disclosure
· Using AI to fabricate, falsify, or manipulate research data, experimental results, or figures
· Uploading a confidential manuscript under peer review to any publicly accessible AI platform or service (this constitutes a breach of confidentiality)
· Listing any AI system as an author or co-author — authorship requires accountability that AI systems cannot provide
Please see www.rams.org for more information.
9. BIOGRAPHY FORMAT
Put the name and address first, in the format for an envelope using RAMS Bio Name & Address Style.  Be sure to include the country at the end (even if USA).  Do not include Smart Tags on the addresses.  Follow the address with a line containing the author’s e-mail address using RAMS e-mail Style that will place the 6 pt spacing before and after the e-mail address.  Do not underline the e-mail address.  Then provide the author’s biography without paragraph indent using RAMS Bio Text Style.  Emphasize the author’s technical aspects.  Be informative so that readers will appreciate the expertise the authors bring to the construction of the paper.  Be sure to include professional society membership information as this is often a condition for receiving society publication awards.
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